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3CPM CENTRAL DATA DEPOT READER & READER © 

Users Manual 

1 Introduction and Overview 
The 3CPM Company’s Electrogastrogram (EGG) Central Data Depot Reader (CDDR), and The 
3CPM Company’s Electrogastrogram (EGG) Reader are designed to import, view, and 
evaluate/re-evaluate patient studies that have been exported by using the 3CPM Export Program. 
The 3CPM export program is designed to be installed on any of The 3CPM Company’s 
Electrogastrogram (EGG) versions. The CDDR allows you to collect multiple patient files that 
have been exported from multiple locations into a single patient database for review and 
analysis. The Reader version has the same features, and operates under the same instructions as 
the full research version with the only limitation being the inability to record a study. Its purpose 
is to allow you full access to studies recorded from the full version. The CDDR version restricts 
the ability to edit the data contained in the exported study in order to preserve the analysis done 
at various locations or on different machines. This version acts as it is named. It is a tool to 
create a Central Data Depot for the accumulation of data into one readable database for analysis. 
In addition, the CDDR gives the users the ability to create instances of the study called “What If” 
scenarios, which allow re-analyses of the data under different parameters without modifying the 
original study. 

NOTE: The CDDR and the Reader program cannot be installed in a machine which 
already has the 3CPM EGGSAS program installed. 

1.1 Overview of the Electrogastrogram 
The 3CPM Company’s Electrogastrogram (EGG) Machine is an EGG analysis system that 
records, stores, displays and prints the myoelectric signals from the stomach as an aid to 
diagnosis of various gastric motility disorders. 

The filter characteristics of the amplifier allow those biological signals with approximate 
frequency ranges from 1 to 15 cycles per minute (cpm) to pass through for recording and 
digitization. Two channels of data are recorded during the session.  One of these is the EGG 
signal itself; the other channel records respiratory rates.  This respiratory recording channel is 
used to help identify artifact in the EGG signal caused by movement, deep breathing, etc.  

The analog signals recorded from the EGG skin electrodes and the respiratory belt are amplified, 
filtered and fed into four cables. The cables are connected to a Human Interface Device, which 
is a small box that contains an analog to digital (A/D) converter for digitization of the EGG 
signal. The signal is then passed digitally via a USB cable to the actual 3CPM Electrogastrogram 
computer. 

The data file that is created during the A/D conversion of the EGG signal undergoes Fourier 
transform (FT), an analysis of the frequencies contained in the EGG signal and a running spectral 
analysis (RSA). A plot of the RSA and calculation of the percentage of power in selected 
frequency bands are reports produced by the EGG analysis system.  
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These EGG data are presented in four major frequency ranges: 
•	 normal (2.5 to 3.75 cpm) 
•	 bradygastria (1.0 - 2.5 cpm) 
•	 tachygastria (3.75 - 10.0 cpm) 
• duodenal-respiratory (10.0 - 15 cpm) 

The data in these ranges are described in four ways: 
1.	 the raw power (log μV2) 
2.	 the percentage distribution of the power in the specific ranges described above 
3.	 the ratio of power based on postprandial to preprandial power 
4.	 the RSA of the EGG recording presented in a pseudo-3-D format 

2 Program Operation 
The 3CPM EGGSAS CDDR and the READER© program both allow you to perform the 
following operations: 

•	 Import a study or group of studies from the files created by the 3CPM EGGSAS 
EXPORT program that integrates into any version of The 3CPM EGGSAS Program. 

•	 View the study data in raw form as well as the report generated in the original study. 
•	 Read and present the Analysis the study. 
•	 Print reports for a study. 
•	 Create your own “What if” scenario and thereby reanalyze the study with different 

parameters while retaining the original studies and reports. 

The 3CPM EGGSAS READER© program also allows complete editing of all data to include 
the parameters set for analysis of the data. 

2.1 Handling the exported study files that are sent to you 
The exported patient files should arrive to you as a folder with the patient files and a database 
containing the data for those exported patients. Should you be sent this export and all the files 
exist but are not in a folder, you will have to create a folder on the computer and copy them into 
it. It is recommended that you create a folder on the desktop called “Imported Studies”, then 
place each exported study folder within this folder. It is also possible that you will get exported 
studies in folders with generic names like “exported files”, etc. It is also recommended that you 
rename these folders to better define exactly where they came from and when. 

2.2 Starting the Program 
The program may be started in one of 2 ways: 

•	 Double click on the desktop icon for the 3CPM EGGSAS CDDR©


program, Or the Reader icon on the desktop. 

•	 Select the Start button, then All Programs, select 3CPM Company, and then 3CPM 

EGGSAS CDDR.exe, or Start button, then All Programs, select 3CPM Company, and 
then 3CPM EGGSAS Reader.exe 
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Once the program is started, the main screen is displayed:  

THE CDDR SNAPSHOTS MATCH THE READER PROGRAM 

3 Importing a Study 
In the “File” menu, select “Import Studies”. This will open the following screen: 

Import Database Screen 
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•	 When you open this screen the first time, the import database from field will be your 
present database. Do not select this. Each time you select a location for the imported 
database the program will remember that location and will start there the next time you 
try to import a database. Therefore you should ALWAYS check the “Select Database to 
Import” button. 

•	 An “Open” screen will appear when you click the select button. It is a standard window 
like all programs use to let you navigate and find files. (example below) 

Open Database Window 

•	 Use the “Desktop” image on the left to navigate to your desktop. Double click the main 
folder you created to store the exported studies, find the study folder you want and double 
click it. The result will look like the image above. 

•	 Select “Open”. 

This will take you back to the “Import Remote Database” screen with the correct database now 
listed. Click the “Import” button. 

You will see a warning box appear over the import screen. This is to give you a moment to make 
sure you are importing the right files so you don’t overwrite files already imported 

This is what it looks like: 
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If you select “NO” it will take you back to the Import remote database screen to allow you to 

reselect, following the above steps. 


Selecting “YES” will begin the import. 


Once the data has been imported, the Import screen will look like this: 


Import Complete 

You can now select “Close” and it will take you back to the main screen. 

3.1 Duplicate Records and Files 
Should you import a patient that already resides in your database, you will first get this warning: 

If you select “Yes” it will overwrite all the data for that name in the database with the data you 
are importing. 

As soon as you make a selection, another warning for the duplicate patient file will appear: 

If you select “Yes” it will overwrite the whole patient file. 

NOTE: You must make the same selection for both each time, unless directed by 3CPM 
technical support! 
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4 Opening a Study 
To select a prior study, first display a list of patients and their studies by using one of the 
following 2 methods. 

• Select the icon to open an existing file, 
• Select File from the top menu and then select Open Prior Study. 

The list of patients and the studies performed on them is displayed in the following screen. 

Figure: Select Patient – Open Prior Study 

If there is currently a study open, and you attempt to open another existing study, and have made 
changes to the current patient information or study and have not saved them, the following 
warning screen is displayed. 

Figure: Warning – Save Patient 

You have the following choices: 
• Yes 

Save the changes to the patient and/or the study and then display the list of patients 
and studies. 

• No 
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The changes to the patient and/or the study are discarded and then the list of patients 
and studies are displayed. 

• Cancel 
The changes to the patient and/or the study are not saved and the list of patients and 
studies is not displayed.  The program keeps the current patient and study. 

If the current study which you are working on is a What If scenario, and you attempt to open 
another existing study, and have made changes to the current What If scenario (see What If) and 
have not saved them, the following warning screen is displayed. 

Figure: Warning – Save What If 

You have the following choices: 
• Yes 

Save the changes to the What If scenario and then display the list of patients and 
studies. 

• No 
The changes to the What If scenario are discarded and then the list of patients and 
studies are displayed. 

• Cancel 
The changes to the What If scenario are not saved and the list of patients and studies 
is not displayed. The program keeps the current patient and study. 

You will notice that the Select Patient Screen now contains both the prior studies and any what if 
scenarios which are those studies under the main study that are indented and preceded by a dash 
(-). 

If research reference numbers are being used, the reference number replaces the patient name. 

Select a patient and a study in one of the following 2 methods. 
• Double click on the patient name (not the date of study). 
• Single click on the patient name and then click OK. 
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4.1 	 Viewing the Study – NOTE: With the CDDR Version You can not 
modify these screens! 

These screens contain the data provided by the various EGG systems after they were analyzed. 
Changing them has been disabled. Use the “What if” option if you need to actually re-analyze 
the data 

NOTE: If you have the 3CPM EGGSAS Reader program and wish to edit 
studies, refer to the manual for the full version of the program that was used 
to export the files. Or just skip to section 5.4.1 in this manual. 

4.2 	 Navigating the Baseline and Post Stimulation Periods 
Navigating between the baseline period and the post stimulation periods can be accomplished in 
several ways: 

•	 Use the View menu at the top of the screen. 

Select from the first section of menu items to go to the specified period. 


•	 Use the Goto menu at the top of the screen. 
Select from the menu items to go to the start of the study (baseline), the previous 
period, the current period, the next period or the end of the study (last period). 

•	 Use the Analyze menu at the top of the screen. 

Select from the first section of menu items to go to the specified period. 


Also note that if the period has been analyzed there is a check mark next to the 
menu item.  This is an easy way of telling if a period has been analyzed. 

•	 Use the dropdown list next to the patient name and date of study. 

Select the dropdown list and then select the period to go to that period. 


•	 Use the Goto icons at the top of the screen just below the menu items. 

Uses the icons as follows: 


This displays the baseline period. 

This displays the previous period. This has no effect if the baseline period is 
being displayed. 

This displays the current period. This is useful if viewing the report or RSA and 
you wish to go back and look at the period you were previously viewing. 

This displays the next period. This has no effect if the last post stimulation period 
is being displayed. 

This displays the last post stimulation period. 
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4.2.1 The Baseline 
The first screen displayed, after selecting a patient and study, is the raw signals in the baseline 
period. 

4.2.2 Post Stimulation Period 
A post stimulation period is displayed as shown in the following screen. 

Notice that the period length and good minutes are already selected.  These are the period length 
and minutes that were selected when the study was previously analyzed. 

4.2.3 Events 
The events for the current period may be viewed using the Events area in the lower right corner 
of the screen. 
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4.3 Viewing the Demographics 
Patient demographics can be edited by selecting View from the top menu and then selecting 
Patient demographics. The patient demographics screen below is displayed. 

Figure: View Patient Demographics 

4.4 Viewing the Diagnostic History 
Diagnostic history can be edited by selecting View from the top menu and then selecting Patient 
diagnostic History. The patient diagnostic history screen below is displayed. 

Figure: Diagnostic History 
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4.5 Viewing the Patient Medications 
Patient medications can be edited by selecting View from the top menu and then selecting 
Patient Medications. The patient medications screen below is displayed. 

Figure: Patient Medications 

4.6 Viewing the Pre-study Information 
Select Edit from the top menu, and then select Pre-Study Information. This displays the pre-
study information 

Figure: Pre-study Information 
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4.7 Viewing the Respiration Rate 
Select View from the top menu and then select Respiration. Select the period you want to view.. 

Figure: Respiration Rate 

4.8 Viewing the Stimulation medium 
Select View from the top menu, and then select Stimulation medium and quantity. This 
displays a window that allows you to see the stimulation medium used. 
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4.9 Viewing the Suggested Diagnosis 
Select View from the top menu, and then select Suggested diagnosis. The following screen is 
displayed. 

Figure: Diagnosis 

4.10Viewing the Recommendation 
Select View from the top menu, and then select Recommendations. 
The following screen is displayed. 

Figure: Patient Recommendations 
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4.11Viewing the RSA 
Select View from the top menu, and then select RSA. 

The RSA is a graph of the spectral estimates of the EGG signals in 4-minute epochs. 


4.12Viewing the Data Sheet 
Select View from the top menu, and then select Data Sheet 

This will display the Data Sheet that is also included in the report. 
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4.13Viewing Events 
Select View from the top menu, and then select Events 

5 Using the What If Scenario for Re-analyzing the Study 
This option allows the user to perform reanalysis of a prior analyzed study, while keeping the 
original study data analysis intact. There is no limit to the number of What If analyses that can 
be performed based on an original study. You can also use the  symbol. 

The data in a What If scenario is as follows: 
• Period start minutes 
• Period lengths 
• Selected good minutes 
• Respiration rates 

5.1 No Prior What If Scenarios 
The What If window is displayed as follows if there are no prior What If scenarios.  
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The “NEW” item is automatically selected.  Enter a description in the Description field. The 
choice: “NEW” or “Original study” is not allowed as What If descriptions. 

After the description is entered, select the Save button to save it. After saving the What If 
scenario, the Recall button becomes enabled.  Then select either Close or Recall button to go 
back to the main display.  The description is displayed above the graphs and to the right of the 
period dropdown list. 

5.2 What If Scenarios 
The What If window is displayed as follows if there are What If scenarios for a study. 

Figure: What If Scenario with What If scenarios 

The list is ordered by descending date and time (i.e. the most recent date and time is at the top of 
the list). The “NEW” and “Original study” listings are always displayed first in the list. 

The What If scenario that is currently being viewed on the main display is automatically 
selected. 

Now the Recall and Delete buttons are enabled. 

A What If scenario is loaded by either double clicking on the scenario in the list or selecting it 
and then selecting the Recall button. 

A What If scenario is deleted by selecting the item in the list and then selecting the Delete 
button. If the currently viewed scenario is deleted and the user just selects the Close button to go 
back to the main display, the original study is displayed (the What If description is no longer 
displayed). 
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5.3 Saving What If Scenarios and Studies 
The data for a What If scenario and the study data are treated differently when saved. 

If a What If scenario is loaded, the Save toolbar button,  will save only the data items in the 
What If data (see the list above).  Any other items that have been changed will not be saved at 
this time. 

Example: 
If a user changes the good minutes in a given period in the currently loaded What If 
scenario and also changes the diagnosis and selects the Save toolbar button,  only the 
data for the What If scenario will be saved. The diagnosis will not be saved. Then the 
user opens the What If window and will be prompted to save the patient data (i.e. the 
diagnosis). 

Each time the What If window is opened, the program checks for any unsaved data in both the 
What If scenario and the study. If either or both have unsaved data, the user will be prompted to 
save the data. 

5.4 Re-analyzing the Study in the What If instance created 

5.4.1 Changing the Baseline 
The first screen displayed, after selecting a patient and study, is the raw signals in the baseline 
period. 

Notice that the good minutes are already selected.  These are the minutes that were selected 
when the study was previously analyzed. 
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You may change the selected minutes by changing either the Start minute or End minute. 
Notice that the Set Good Minutes becomes unchecked.  You must check it again to accept the 
new good minutes. 

WARNING – Changing the baseline minutes will erase all selected minutes or subsequent post 
stimulation periods.  The What If scenario option should be used to perform reanalysis if you 
would like to preserve the original analysis. 

5.4.2 Change a Post Stimulation Period 
A post stimulation period is displayed as shown in the following screen. 

Figure: Main Screen – Re-Analyze Post Stimulation Period 

Notice that the period length and good minutes are already selected.  These are the period length 
and minutes that were selected when the study was previously analyzed. 

You may change the period length by changing either the Start minute or End minute. Notice 
that the Set Period Length becomes unchecked.  You must check it again to accept the new 
period length. Also notice that the Set Good Minutes has become unchecked.   

You may change the selected minutes by changing either the Start minute or End minute. 
Notice that the Set Good Minutes becomes unchecked.  You must check it again to accept the 
new good minutes. 

WARNING - Changing the post stimulation periods or minutes will erase all prior selected 
minutes or subsequent post stimulation periods, if the newly selected periods or minutes are 
saved. The What If scenario option should be used to perform reanalysis if you would like to 
preserve the original analysis information. Use the Reset Periods Button and then set the proper 
periods you wanted 
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5.4.3 Changing Events 
The events for the current period may be changed using the Events area in the lower right corner

of the screen. 


Select an event from the list.  The description is displayed below it. 


Select Edit to change the event. You cannot change the time of the event. 


Select Delete to delete the event. The following warning is displayed. 


Select Yes to delete the event and No to if you don’t want to delete the event. 

5.5 Changing the Diagnosis 
Select Edit from the top menu, and then select Suggested diagnosis. 

If you have previously entered a diagnosis, you may also change it by selecting Edit from the top 
menu and then selecting Suggested diagnosis. 

5.6 Changing the Recommendation 
Select Edit from the top menu, and then select Recommendations. This displays a window that 
allows you to change the recommendations. 

5.7 Changing the Pre-study Information 
Select Edit from the top menu, and then select Pre-Study Information. This displays a window 
that allows you to change the pre-study information. 

5.8 Stimulation medium 
Select Edit from the top menu, and then select Stimulation medium and quantity. This displays 
a window that allows you to change the stimulation medium.  
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5.9 Change number of minutes per graph 
The number of minutes, as they are viewed, per graph is initially set to 4 minutes.  This may be 
changed by selecting View from the top menu and then selecting Change number of minutes per 
graph. The following window is displayed. 

Figure: Change number of minutes per graph 

Enter the number of minutes you want to see displayed on each graph and then select OK to save 
the number of minutes per graph.  The graphs will change according to the number of minute 
entered. 

6 Reports 
The default or standard report consists of 2+ pages organized as follows: 

•	 Page 1 

− Facility information at top of page 

− Patient information 


o	 Patient name 
o	 Date of study 
o	 Attending physician 
o	 Referring physician 
o	 Technician 
o	 Indications 
o	 Stimulation medium 
o	 Diagnosis 
o	 Recommendations 
o	 Signature and date 

•	 Page 2 

− RSA 


•	 Page 3 plus required additional pages

− Raw data graphs of the selected minutes.  One graph per period. 
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6.1 Configuring Reports 
Reports can be configured to include/exclude the following items. 

•	 Patient information 
•	 RSA 
•	 Data Sheet 
•	 Raw data graphs of the selected minutes.  One graph per period. 
•	 Graphs of the entire raw signal starting on the next available page until all graphs are 

printed. 
•	 Event log 

Configure the graphs by selecting Report from the top menu and then selecting Configure 
Report. The following screen is displayed. 

Configure Report 

Select the items you want included in the report or de-select the items that you want removed 
from the report.  Select OK to put the items in the report. 

Select Cancel to leave the report unchanged. 
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6.2 Facility Information 
Facility information can be entered at any time.  Select Report from the top menu and then select 
Facility/practice information. The following screen is displayed. 

Figure: Facility Information 

Enter the information and select Save and close to save the information in the database. 

Cancel discards any newly entered information and leaves the facility information unchanged in 

the database. 


The information initially entered will appear at the top of all reports, unless edited. 


6.3 View/Printing 
Once the study has been analyzed, the report can be viewed by selecting Report from the top 
menu and then selecting View report.  While the report is being viewed, it can be printed. 

Print the report using one of the two following methods. 
• Select the print icon,  from the top menu. 
• Select Report from the top menu and then select Print report. 

Either of these methods displays a standard Windows Print screen. 
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Select Printer 

7 Backing Up and Restoring Data 
You can backup or restore your data by selecting File from the top menu and then selecting 
Backup or Restore. The following screen is displayed. 

Figure: Backup/Restore Data 

- 24 -



7.1 Backup 
Select Backup. A standard Microsoft Windows “Save as” screen is displayed.  The File name is 
“3CPM EGGSAS.MDB”.  The file name must not change.  Navigate to the directory (including 
Network directories) or drive where you want to backup the data to and select Save. 

For example, your data is on the C: drive and you select D: drive (the CD drive) to backup up 
your data to. Once you select Save from the standard Microsoft Windows “Save as” screen, the 
above screen is changed to: 

Figure: Backup Data 

Select Start to start the backup. During the backup, the file being copied is displayed under File 
being copied. Also the field next to the text “Backup” displays the progress of the backup. 

If the backup has completed successfully, the following screen is displayed. 

Figure: Backup Complete 

Select OK. Then select Close from the above screen. 

If the backup fails, an appropriate error message is displayed indicating what may be wrong.  
The following is a list of possible errors. 

•	 There is no destination disk in the selected drive. 
•	 The destination disk is full. 
•	 The file already exists. This message is only displayed once.  If you elect to overwrite 

the first file, then all additional files are overwritten. 
•	 There is an error writing to the directory/disk.  This may occur for a number of reasons. 

− If you are writing to a CD, try another CD, the CD may be damaged. 
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−	 If you are writing to a directory (either on the local PC or on the network) make sure 
you have permission to write. 

7.2 Restore 
To restore data from a backup, exit the program, restart the program and select File from the top 
menu and then select Backup or Restore. 

IMPORTANT NOTE: 
Restoring data will only work if it is the first action performed after starting the 
program. 

The initial Backup/Restore data screen is displayed (Figure: Backup/Restore Data). 

Select Restore. A standard Microsoft Windows “Open” screen is displayed.  The File name is 
“3CPM EGGSAS.MDB”.  The file name must not change.  Navigate to the directory (including 
Network directories) or drive where you have the backup data you want to restore and select 
Open. 

For example, your backup data is on the D: drive in the directory “EGGSAS data 13-14 Feb 04”.  
Once you select Open from the standard Microsoft Windows “Open” screen, the screen shown in 
Figure Backup/Restore Data is changed to: 

Figure: Restore Data 

Select Start to start the restore. During the restore, the file being copied is displayed under File 
being copied. Also the field next to the text “Restore” displays the progress of the restore. 
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If you are restoring over an existing database, you will get the following message. 

Figure: Overwrite 

If you want to overwrite the existing database and data files, select Yes and the restore operation 
will continue.  If you don’t want to overwrite the existing database and data files, select No and 
the restore will stop. 

If the restore completes successfully, the following screen is displayed. 

Figure: Restore Complete 

Select OK. Then select Close from the above screen (Figure: Restore Data). 

If the restore fails, an appropriate error message is displayed indicating what may be wrong.  The 
following is a list of possible errors. 

•	 There is no source disk in the selected drive. 
•	 The destination disk is full. 
•	 The file already exists. This message is only displayed once.  If you elect to overwrite 

the first file, then all additional files are overwritten. 
•	 There is an error writing to the directory/disk.  This may occur for a number of reasons. 

− If you are writing to a directory (either on the local PC or on the network) make sure 
you have permission to write. 

−	 If you have performed any other action with the program, close the program and 
restart it. 
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8 Closing the Program 

The program can be closed in the following ways: 
• Click on the X in the upper right corner of the main program screen. 
• Select File from the top menu and then select Exit. 

If you made changes to the current patient information or study and have not saved them, the 
warning screen shown in figure Warning – Save Patient is displayed. 

If you made changes to the current patient What If scenario and have not saved them, the 
warning screen shown in figure Warning – Save What If is displayed. 

You have the following choices: 
• Yes 

Save the changes to the patient and/or the study or the What If scenario and then close 
the program. 

• No 
The changes to the patient and/or the study or the What If scenario are discarded and 
then the program is closed. 

• Cancel 
The changes are not saved and the program is not closed. 

NOTES: 
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